ft SAL

huide

Systeme GmbH

DM

THE WORLD OF CAD AND PDM SOLUTIONS

..‘0000.

W

¢ I )

UNLIMITED P’E"R'F‘ORMANC‘E |




THE WORLD OF CAD AND PDM SOLUTIONS

Microsoft SQL Server 2016

MiICTOSOTE SAL SEIVEE 2016 ..ottt bbbt bbb bbb s s bbb bbb n st aees 1
1 IETOAUCTION ..ottt bbb a bbbt s bbbttt b ettt n ettt aeen 3

Installation 0f the DAtADASE SEIVET ..........cveivcicccec s 4
2.1 Installation of the Datahase MOGUIE ..........ccucueieiucicc ettt 4

SELING UP the SQAL SEIVEE 2014.......eeeeeeeeeee ettt sttt et as s st st s st s st snanssnantanansanans 13
3.1 Setting Up the Conditions for Database IMPOMt ...t 13
4 IMPOrting the HELIOS DAtADASE ........uvevicececeeeeceee ettt sttt a s es sttt nassaneaneaeen 16
41 Installing the HELIOS Datahase CrEatOr..........eveveicvcvcicieeeeee ettt sttt sas sttt s s ss sttt s sansaneanes 16
4.2 Importing the Database with the HELIOS Database Creator........c..ccocuieeeiciccceceeeeeee ettt aes 19
5 Defining the Permissions for the USEr RICAL...............cc.cuiuiueieeeececcec et 22
6 Setting Up the ODBC COMNBCTION ......e.veveevcectctceeee ettt s sttt ns e s 25
7 Establishing the HELIOS CONNECTION ........cvucvieiecieicicctc ettt 31

ISD Software und Systeme GmbH, Microsoft SQL Server 2016, 28.11.2022 Page 2/31



TS TRC 2

THE WORLD OF CAD AND PDM SOLUTIONS

1 Introduction

The HELIOS - PDM - Module (document management, component management, Workflow, etc.) are based on a
relational database. Before start of HELIOS, the Microsoft SQL database control system must be installed on the
server, a database imported and the clients ODBC connection has to be established.

The following installation instructions refer to the installation of the English Version of SQL Server 2016 Standard
Edition. Other editions may require minor variations in the installation process.

For detailed information about Microsoft SQL Server 2016, please refer to the Microsoft documentation, or the
Help on the Microsoft website:

https://msdn.microsoft.com/en-gb/library/ms143531.aspx

Please note that the Microsoft SQL Server 2016 can only be used with HELIOS 2016 (SP1) or higher.

Please note:

e |f you are working with HELIOS and ordered the SQL Server software
via ISD, please only use the DVD or ISO file supplied by ISD for the
installation of the SQL Server.

If you want to install a German SQL Server on an operating system

with a different language, please switch Language and Region to
DE/DE; otherwise, the setup routine will not start. You can switch
back again after installation. (The same applies to the combinations
German/Switzerland and German/Austria)
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2 Installation of the Database Server

2.1 Installation of the Database Module

Shortly after starting the setup, the installation screen will appear as shown below:

5 SOL Server Installation Center — O >
~
Planning = Hardware and Software Requirements
Installation View the hardware and software requirements,
Maintenance = Security Documentation
Tools View the security documentation.
Resources = Online Release Motes
Advanced View the latest information about the release.
Options ?‘-ﬁ System Configuration Checker

Launch a tool te check for cenditions that prevent a successful SQOL Server installation,

g Downlead Upgrade Adviser

Upgrade Advisor analyzes SQL Server components that are installed and identifies
issues to fix either before or after you upgrade to SCQL Server 2016,

= Online Installation Help

Launch the online installation documentation.

=2 How to Get Started with SCL Server 2016 Failover Clustering
Read instructions on how to get started with SQL Server 2016 failover clustering.

i= Get Started with the installation of Power Pivot for SharePoint

Read how to install, configure, and verify an installation of Power Pivot for SharePoint,

Eh Get Started with the Installation of Reperting Services SharePoint Mode

Read how to install, configure, and verify an installaticn of Reporting Services in
SharePoint mode.

Microsoft” SQL Server 2016

= Upgrade Decumentation

View the dornment ahent howe to o e to SO Server 2016 from a nrevinns wersinn

Imagel: Start page of SQL Server Installation Centre

On the left hand side of the window, select the Installation menu item.

Then, on the right side of the screen, click New SQL Server stand-alone installation or add features to an existing
installation.
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5 S0L Server 2016 Setup - [} X

Product Updates

Always install the latest updates to enhance your SQL Server security and performance.

Product Key
Include SQL Server product updates
License Terms

Global Rules MName Size (MB) Maore Information

Product Updates Critical Update for SQL Server 20... | 37 KB 3164398

Install Setup Files
Install Rules
Feature Selection 1 updates (37 MB) found online,

Feature Rules The Setup updates (37 MB) will be installed when you click Mext.
Feature Configuration Rules

Ready to Install

Installation Progress

Complete

Read cur privacy statement cnline

Learn more about SQL Server product updates

< Back Mext = Cancel

Image 2: Settings for product updates

T SOL Server 2016 Setup - ] x

Install Rules

Setup rules identify potential problems that might occur while running Setup. Failures must be corrected before Setup
can continue.

Install Rules Operation completed. Passed: 5. Failed 0. Warning 0. Skipped 0.

Feature Rules

Instance Cenfiguration Show details >> [T
Server Configuration View detailed report

Database Engine Configuration
Feature Configuration Rules
Ready to [nstall

Installation Progress

Complete

= Back Mext = Cancel

Image 3: Install rules
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5 SOL Server 2016 Setup — O X

Product Key

Specify the edition of SQL Server 2016 to install.

Product Key Validate this instance of SQL Server 2016 by entering the 25-character key from the Microsoft certificate
License Terms of authenticity or preduct packaging. You can also specify a free edition of SOL Server: Developer,
Evaluation, or Express. Evaluation has the largest set of SQL Server features, as documented in SQL Server
Global Rules Books Online, and is activated with a 180-day expiration. Developer edition does not have an expiration,
Product Updates has the same set of features found in Evaluation, but is licensed for non-production database application

Install Setup Files development only. To upgrade from one installed edition to another, run the Edition Upgrade Wizard.
Install Rules o

Specify a free edition:
Feature Selection Specify

Feature Rules Evaluation

Feature Configuration Rules @) Enter the product key:

Ready to Install ||

Installation Progress

Complete

< Back Mext = Cancel

Image 4: Enter Product Key
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Accept the license terms and click Next.

T SOL Server 2016 Setup - O x

License Terms

To install 5QL Server 2016, you must accept the Microsoft Software License Terms.

Product Key ~
MICROSOFT SOFTWARE LICENSE TERMS

License Terms

Global Rules MICROSOFT SQL SERVER 2016 STANDARD

Product Updates

These license terms are an agreement between Microsoft Corporation (or based on where you
live, one of its affiliates) and you. Please read them. They apply to the software named above,
Install Rules which includes the media on which you received it, if any. The terms also apply to any

Feature Selection Microsoft

Install Setup Files

Feature Rules » updates,

Feature Configuration Rules
Ready to Install » supplements,

Installation Progress .
9 » Internet-based services, and

Complete
&  cunnnrt servires W
B S
Copy  Print

| accept the license terms,

SQL Server 2016 transmits information about your installation experience, as well as other usage and
performance data, te Microsoft to help improve the product. To learn more abeut SOL Server 2016 data
processing and privacy controls, please see the Privacy Statement.

< Back Next » Cancel

Image 5: Accept Licence Terms
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Select the highlighted features:
- Database Engine Services
- Documentation Components

Confirm the selection and click Next.

T SOL Server 2016 Setup - d =

Feature Selection

Select the Standard features to install.

Install Rules Eeatures: Feature description:
Feature Selection Instance Features * || The configuration and operation of each A
Feature Rules Database Engine Services instance feature of a 5QL Server instance is
Instance Configuration [] SQL Server Replication isolated from other SCL Server instances. SGL

[ R Services (In-Database) Server instances can operate side-by-sideon = ¥
Server Configuration

[] Full-Text and Semantic Extractions for Sea Prerequisites for selected features:
[ Data Quality Services
[ PolyBase Query Service for External Data
Ready to Install [ Analysis Services
Installation Progress [] Reporting Services - Mative
Shared Features

[] Reporting Services - SharePoint

[ Reporting Services Add-in for SharePoint Pro Drive C: 1085 MB required, 126365 MB

Database Engine Configuration

Already installed: A
Windows PowerShell 3.0 or higher

Micrnsoft Visnal Studin 2010 Redistributable ¥
>

Feature Configuration Rules

Complete Disk Space Requirements

[] Data Quality Client v || available
< >
Select All Unselect All
Instance root directory: C:\Program Files\Microsoft SOL Server',
Shared feature directony: C:\Program Files\Microsoft SQL Server',

Shared feature directory (x86): c:\Program Files (x86)\Microsoft SOL Server!,

< Back Next > Cancel

Image 6: Feature selection
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In the dialogue shown below, specify the name of the SQL Server instance. In this manual, the Default instance
is used.

T SOL Server 2016 Setup - O X

Instance Configuration

Specify the name and instance ID for the instance of SOL Server. Instance ID becomes part of the installation path.

Install Rules (® Default instance

Feature Selection O Named instance: | MSSQLSERVER
Feature Rules

Instance Configuration

Server Configuration Instance |D: MSSQLSERVER

Database Engine Configuration

Feature Configuration Rules

Ready to Install SQL Server directory:  C\Program Files\Microsoft SQL Server\MS50L13.MSSQLSERVER

Installation Progress 5
Installed instances:

Complete
Instance Mame Instance D Features Edition Version
SCOLEXPRESS MSSCL12.5CLEXPR.., | SCOLEngine Express 12.1.4213.0
«Shared Compone... S5MS 12.1.4213.0
< Back Next > Cancel

Image 7: Instance Configuration
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Then, define under which service accounts the services are to be launched.

Apply the settings shown below and click Next.

T SOL Server 2016 Setup - d *

Server Configuration

Specify the service accounts and collation configuration.

Install Rules Service Accounts  Collation

Feature Selection

Microsoft recommends that you use a separate account for each SQL Server service,
Feature Rules

Instance Configuration Service Account Name Password Startup Type

Server Configuration S0OL Server Agent NT Service\50LSERVERA... Automatic |~
Database Engine Configuration S0L Server Database Engine NT Service\M3S0LSERVER Automatic |~
Feature Configuration Rules SQL Server Browser NT AUTHORITY\LOCAL... Automatic v

Ready to Install

Installation Progress [] Grant Perform Volume Maintenance Task privilege to SOL Server Database Engine Service

Complete This privilege enables instant file initialization by avoiding zeroing of data pages. This may lead
to information disclosure by allowing deleted content to be accessed.

Click here for details

< Back Next > Cancel

Image 8: Service accounts: Startup Type is set to “Automatic”
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After clicking Next the authentication mode shall be specified. Select the Mixed mode. Enter the password for

the internal database administrator (SA). In the Specify SQL Server administrators field, enter the current user

and the group of Windows — Administrators (will be added automatically as the case may be).
Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Product Key Server Configuration | Data Directaries | FILESTREAM
License Tetms
Specify the authentication mode and administrators for the Database Engine.

Global Rules

Product Updates Authentication Mode

Install Setup Files = windows authentication mode

Install Rules " Mixed Mode (SQL Server authentication and Windows authentication)
Setup Rale

Fegiune SkdiEn Specify the password Far the SQL Server system administratar {sa) account.

Feature Rules Enter password: I.....

Instance Configuration

9 Confirm password: quo
Server Configuration
Database Engine Configuration Specify SOL Server administrators

Feature Configuration Rules

SGL Server administrators have
unrestricted access to the

Ready to Install ;
Database Engine.

Installation Progress

Complete

AddCurrentUserI add... | Removel

< Back et > Cancel Help

Image 9: Authentication mode
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Now an overview of all settings which made by the user is shown. Click Install to start the installation of the SQL
Server 2016.

After successful installation, additional information and the status of functions will be shown.
Click Close to finalize the installation.

Complete

Wour SQL Server 2014 installation completed successfully with praduct updates.

Product Key Information about the Setup operation or possible next steps:

License Terms
Global Rules

| Feature | Status

& Management Tools - Complete Succesded

Product Updates | Management Tools - Basic Succeeded
Install Setup Files b Database Engine Services Succesded
Install Rules b SOL Browser Succesded
Setup Rele b Dacurnentation Components Succeeded

. b SOL Wiriker Succeeded
Feature Selection b Setup Support Files Succeeded
Feature Rules
Instance Configuration
Server Configuration
Database Engine Configuration Details:
Feature Configuration Rules — -

Viewing Product Documentation for SQL Server o

Ready to Install
Installation Progress Only the components that you use to view and manage the documentation for SAL Server have been
Complete installed. By default, the Help “iewer component uses the online library. After installing SCL Server,

you can use the Help Library Manager component to download documentation to your local computer.
For more information, see Use Microgoft Books Online for SGEL Server (<http oo microsoft cormfwlinks?

Link|D=29957 5.

Microsoft Update

Summary log file has been saved to the Following location:

CiiProgram FilesiMicrosoft SOL ServerilZ0Setup Bookstrapilogl20150303 145142
Surnmaty S01 20150303 145142 kxk

Clase Help |

Image 10: Finalise installation

To configurate the SQL Server 2016 you need the SQL Server Management Studio tool.

You can download the tool directly from the Microsoft website:

https://msdn.microsoft.com/en-us/library/mt238290.aspx
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3 Setting Up the SQL Server 2014

3.1 Setting Up the Conditions for Database Import

To configure the SQL database, click the Start icon on the Windows task bar and select All Programs > Microsoft
SQL Server 2016 > SQL Server Management Studio (it might have to be installed separately).

In the login window, specify the Server name in the same-named field. Enter SQL Server Authentication in the
Authentication field, sa in the Login field and the password you specified during installation in the Password

field. Click Connect.

gﬂ Connect to Server

SQL Server

pos

TEST-DOKU-EN Dol

Cancel Help Options >>

Server type: Database Engine W
Server name: |VM-PC"-.MSSOLS ERVER| v
Authentication: Windows Authentication w~

Image 9: Connect in the Management Studio

l.: Microsoft SOL Server Management Studio
File Edit Wiew Debug Tools ‘Window Help
Pl i T e | S ewouery [y R D D
Object Explorer * 1 X
Connect = g 3 @m E;
= | Q501\SQLERPRESS (SCL Server 12.0,2000
1 Databases
[=1 [ Securiby

La
Ca Mew Lagin...

£.-
OEE S I B

] Filker

1 Ser
[ Ref Start PowerShell

[ Mar
Reports

Refresh

Image 10: Microsoft SQL Server Management Studio

In the left area of the window, expand the folder Security, right-click the Logins sub-folder and select New Login

in the context menu.
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The following window will be displayed:

E Login - New =]
Seectapage 5 Script - lrj Help
2 General
4 Server Roles . -
Eﬁi User Mapping Login name: Ihlcad Search... |
2 Securables = windows authentication
]
= Status ¥ SOL Server authentication
Pazzword: |-uu
Confirm pazsward: I""'

= Specin old pazswond

0ld pazsword: I
[ Enfarce pazsward policy
™| Enfores password expiration

™| Wser must change pazsword at nest login

{~ tapped to certificate I

" Mapped to asymmetric key I

I b ap to Credential I

Connection

Mapped Credentials Chzalrie]

| Provider |

Server
LSOTNSALEXPRESS

Connection:
3a

&3¢ View connection properties

Hemaowe |

Ready Default database: ImaSlEf

Default language: |<default>

[
-~

]

Cancel |

4

Image 11: Creating the User hicad
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Enter hicad in the Login name field, activate the SQL Server authentication option and enter a password. Then,

deactivate the Enforce password policy option and open the User Mapping menu.

Activate, as shown in the image below, the model database and enter hicad in the Default Schema column.

Confirm with OK.

E Login - New

12 General

25 Server Roles
_’@ zer Mapping
2 Securablss
57 Status

Server
[lazal)

Connection:
3a

&4 View connection properties

Ready

Selectapage g Script - l:j Help

=10 %]

Uzers mapped to this login:

I Guest account ensbled for: mode!

[ atabasze role memberzhip for: model

tap | Databaze | I zer | Default 5chema |
- rnaster
W model hicad  hicad -
[l mzdh
il termpdb

[ db_acceszadmin
[] db_backupoperator
[ db_datareader
db_datawriter
db_ddladmin
db_derydatareader
db_derywdatawriter
[ db_owimer

[ db_zecurtyadmin
[w| public

|
|
|
|

(1] I Cancel |

Image 12: User Mapping
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4 Importing the HELIOS Database

4.1 Installing the HELIOS Database Creator

To install the HELiOS Database Creator click the same-named button in the HELIOS installation mask:

e Administrator Tools Server Installations
O This component may only be installed on the License Sarver! HELIOS Vault Server |
q o — SafeNetLicense-Server | HELIOS SmartSearch Server ]
HELIOS Database Creator | HELIOS Intemet Server |

HELIOS Application Server |

HELIOS Spooler |

Image 13: Installation DVD with HELIOS Database Creators
The start mask of the setup wizard of the HELIOS Database Creator will then be displayed.

i'-.E‘ HELiOS Database Creator Setup = |

Welcome to the HELIOS Database
Creator Setup Wizard

TSI~

The Setup Wizard will install HELIOS Database Creator on
wour camputer, Click Mext bo continue or Cancel ko exit the
Setup Wizard,

Barh I Mext I Cancel

Image 14: Database Creator - Setup wizard

Click Next.
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Specify an installation directory for the HELIOS Database Creator, and click Next.

ji& HELiDS Database Creator Setup I =] |

Destination Folder
1 o

Please select the installation Folder

Inskall HELIOS Dakabase Creator bos

IC:'I,F'ru:ugram Files\ISD Sofbware und Systeme\HELIOS Database Creator!

Change. .. |

Back. I Mext I Cancel

Image 15: Specify target folder

Click Next, then click Install to start the installation.
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Click Finish to finalize the installation of the HELIOS Database Creator.

i':_-?u HELiDS Database Creator Setup ;IE'EI

Completed the HELIOS Database Creator
Setup Wizard

TS TEC =2

Click the Finish button to exit the Setup Wizard.

Bark: I Finish I Zance|

Image 16: Finalise HELIOS Database Creator installation
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4.2 Importing the Database with the HELIOS Database Creator

Click the Start icon on the Windows task bar and select All Programs > ISD Software und Systeme > HELIOS
Administration > HELiOS Database Creator.

After entering the user data — User: sa, the Password and the SQL Server to be connected — you will be logged
in.

HELil]S - Database Import-/Export Tool Ed |

L ogin /A ogout

User: |sa |

Password;

Server: |QSEII A | Local

I Login

Image 17: HELIOS Database Import/Export tool
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For older versions, it was necessary to copy the empty HELIOS database from the installation DVD
(\Helios\Datenbanken\MsSql80\bauteil_sic ) to a temporary directory of the server. As of HELIOS 2014 SP1
(Version 1901.1) it is also possible to directly import the database from the DVD to an empty directory, without
this intermediate step.

For HELIOS versions older than HELIOS 2023 Service Pack 1 (V 2801) you will find the database in the
subdirectory \Datenbanken\bauteil_sic\, from Version 2801 it is located in the directory \Databases\en\.

The log file for the process will be saved to BAppdata %\RoaminglISD Software und
SystemelHELIOS|bauteil_akt| Helios_Export.log and the configuration will be saved to ZAppdata % |\Roaming
|/ISD Software und SystemelHelios. DBImportExport\DBImportExportConfig.xim/

In this guide the database name bauteil (German for “part”) is used. Enter the export path and the database
name and start the Import by clicking the same-named button.

Exports to directories which already contain files are no longer possible. In this case an appropriate error
message will be displayed.

Import / Export
Database: | HELIOS -
Import/export path: |F:‘-‘Databases‘-‘en E
Export ” Import |
- Export settings @

Llzer =a, Server: (local)

Image 18: Start import
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The import procedure will be recorded in an import log:

4, HELIOS - Database Import-/Export Tool >

Import / Export
Database: |HELiOS -
Import/export path: |F:KDatahase5‘-‘en B
Export | [ Import |
— Export settings @

T T =
BCP: "[HELIOS].[hicad].[ZIELTERMIMN_STATUS]" in "K:"'.HE|iD5"kDEtEH|:IEr1|[—I
Starting copy...

0 rows copied.
Metwork packet size (bytes): 4096
Clock Time (ms.) Total :1

Ende Bulkimpeort Tabelle ZIELTERMIN_STATUS
Ende Bulkimport Datenbank HELIOS aus Crdner K:EHEIiDs&DatenbanE@

K

Uszer; =a, Serven (local)

Image 19: Import log

If the import was successful, this will be indicated by a corresponding message. Confirm with OK.

Information

Operation successfully complatad.

Image 20 : Import successful
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5 Defining the Permissions for the User hicad

Switch to the SQL Server Management Studio to define the permissions of the user hicad.

Expand the Databases folder, right-click bauteil and select the Properties function in the context menu.

l‘: Microsoft SQL Server Management Studio

File Edt Wiew Debug Tools ‘Wwindow Help
Pl S | ewouery (0 1 D
Object Explorer > I x

Connect~ 33 3 w7 (2] L5
= Ld Q501 (3QL Server 12.0,2000 - 5a)
[ [ Databases
[ System Databases
[ Database Snapshots
L
Bl [ Securiy Hew Database. ..
[ Logins
[ Server
[ Creder Script Database as
[ Crypto
[ Audits
[ Server
[ Server Obj
[ Replication Facets
[ Alwayson
| Manageme
[ Inkeqgratior Reports
Lﬂ) S0L Serven

MNew Quety

Tasks

Policies

Skart PowerShel

Rename

Delete

Refresh

Propetties

|n

Image 21: Calling the Properties of “bautei
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On the left side of the window, select Permissions. Define the permissions for the user hicad.

- Database Properties - bauteil H=]
Seeclanage L8 Seript - [ Help
2 General
# Files
E;i Filegroups Server name: IQSEH
_’Q Options Wigw sErvel DEMmiszions
- .
) Ehan.ge. Tracking [atabasze name: Ibauteil
1% Permissions
f Estended Properties Users & falee Search... |
18 Mimaring
_’@i Tranzaction Log Shipping I Mame I Type I I
M i hicad | User By
Permizszions far hicad:
. Explicit I Effectivel
Permnizzion | GGrart | With Grant | Dery |:|
aesrg‘.lar: Create table 5 v | |
_ Create tpe il |l |l
SE:nneu:tan. Create view [l I I
2 v, : : Create #hL schem... il |l |l
iew connection properties
Delete v I I
e - = =
ol Inzert v - - J
Ready Refererces il |l |l
Select I |l |l -|
Qg I Cancel |
Y
Image 22: Permissions for hicad
Assign the following permissions to the user hicad:
» Update
» Select
» Insert
»  Modify
» Delete
» Create table
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6 Setting up the ODBC Connection

To set up the ODBC connection for the clients, click the Start icon on the Windows task bar and select Control
Panel > Administrative Tools > Data Sources (ODBC).

The ODBC data source can be set up either as a System DSN (by an administrator) which will be available to all
users of the computer, or as a User DSN which will only be available for the user who has created it. The
procedure for both options is identical.

In the ODBC Data Source Administrator, click the Add button.

&% ODBC Data Source Administrator E |

UserDSM - System DSM IFiIe DSH I Driversl Trau:ingl Connechion P'u:u:ulingl About |

System Data Sources:

Mame | Driver | Add.. |

Eemoyve |

Canfigure...

_ . An ODBC System data source stores information about how to connect to
D; the indicated data provider. & System data source iz vizible to all ugers
= on this machine, including HT services.

k. I Cancel Spply Help

Image 23:0DBC Data Source Administrator
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In the Create Data Source dialogue window, select the SQL Server Native Client 11.0 and click Finish.

Create MNew Daka Source |

Select a driver for which pau want to zet up a data zource.

; Hame I Vers

E Microsoft docess dBASE Driver [*.dbf, * ndx, “mds] 14.0
7 _E_ Microsoft Access Driver [*.mdb, *.accdb] 14.0
e Microzoft Access Test Driver [k, " cav] 14.0
Microzoft Excel Driver [7 sz, * wlze, * wlzm, ™ wlzh) 14.0

QDB Driver 171 for SGL Server 201

SAL Server E.01

SAL Server Mative Client 11.0 201°

1] | i

< Black I Finizh I Cancel

Image 24: Select ODBC driver

Now enter the name of the data source (in the following HeliosBauteil), and enter the name of the database
server or select it from the list. Confirm your entries with Next:

Creakte a New Dakta Source to SOL Server E |

T hiz wizard will help pou create an ODBC data zource that you can wze to connect o
hi SOL Server.
p-.

YWhat name do you want to uze to refer to the data source’y

Al et ¥
SQL Server 2012

M arne: IHE“DSB auteil

Haow do pou want o dezcribe the data source?

D escription: I

Which SOL Server do pou want to connect o

Finizh I et > Cancel Help

Image 25: Definition of the data source
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Activate the With SQL Server authentication... option, enter hicad in the Login ID field and your Password in the
same-named field below.

Create a New Dakta Source to SOL Server |
How should SOL Server verfy the authenticity of the login (D7
.
)
L - = With Integrated Windows authentication,
SOL Server 2012

SEN (D ptional]: |

= 'With SHL Server authentication uzing a lagin |0 and pazsword entered by the
LIZEL.

Lagin ID: |hicad

Pazzword: I" ses

< Back I MHext > I Cancel Help

Image 26: User input
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THE WORLD OF CAD AND PDM SOLUTIONS

Activate the Change the default database to: checkbox and select the bauteil database. All other options must
correspond to those shown in the image below:

Create a New Data Source to SOL Server |
¥ Change the default database b
.
> =]
H SEI;UEF 2012 Mirror server:

SPM far mirrar zerver [0 ptional]:

[ Attach databasze filename:

[V Usze ANS| quoted identifiers.
¥ Usze ANSI| nulls, paddings and warnings.

Application intent:
|READWRITE =
[~ Multi-subnet failover.

< Back I MHext > I Cancel Help

Image 27: Database selection
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THE WORLD OF CAD AND PDM SOLUTIONS

Deactivate all options and click Finish to finalize the creation of the connection.

Create a New Data Source to SOL Server |
% [~ Change the language of SEL Server spstem messages bo:
‘_;'_.

| (Detaul) =]

[T Use strang encryption for data

W S-EI;UEF 2014

[ Perform tranzlation for character data

[~ Usze regional zettings when outputting currency, numbers, dates and brmes.

[T Save long running quenes o the log file;

IE:'\LI zerzhgzhappDatatLocalhTemp QUERY . LOG Browse... |

Long query time: [millizeconds]: |3|:||:||:||:|

[” Log ODBLC driver statistics to the log file:
IE:"sLI zerzhgzidpplatatlocalh TemptSTATS.LOG Browse, . |

¢ Back I Finizh I Cancel Help

Image 28: Settings for ODBC connection
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THE WORLD OF CAD AND PDM SOLUTIONS

The window below offers the option to test the data source and completely finalize the creation by clicking OK.

The ODBC Data Source Administrator can now be closed as well.
ODEC Microsoft SOL Server Setup |

& new ODBC data zource will be created with the following configuration:

Microzoft SOL Server Mative Client Wersion 11.00.3000 ;I

D ata Source Mame: HeliozB autel
Data Source D escription:

Server: 0501

Ize Integrated Security: Ma

D atabaze: bauteil

Language: [Default]

Drata Encryption: Mo

Trust Server Certificate: Mo

Multiple Active Result Setz[MARS]): Ho
birror Server:

Translate Character Data: Mo

Lag Lang Running Quenes: Ma

Log Crriver Statistics: Mo

Iz Regonal Settings: ez

IJge AMSI Quoted |dentifiers: ez

Iz ARSI Mull, Paddings and " arnings: Yes

[

Test Data Source. .. I (] | Cancel |

Image 29: Testing the data source and complete finalization of the creation
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THE WORLD OF CAD AND PDM SOLUTIONS

[  Establishing the HELiOS Connection

Finally, you need to tell HELIOS the name of the data source you have defined in the previous chapter. Click the
Start icon of the Windows task bar and select All Programs > ISD Software und Systeme > Administration > DB

Manager. Activate the Connections tab.

i{ HeliosDbManager |
General I Export I [mport I Conversion I Update Connections I Toolz I

Databaze server MSSHL

Character set of database server: Ir‘ ko Ir‘ DEM |f* AMS|
 |Connechion bo master data database

Computer data source IHeIinsBauteiI
ILI ser name ¢ Data view Ihiu:au:l

IF'assw-:uru:I I“““““

Cormputer data source HeliozB autel

IJzer name 4 Data view hicad

Pazsward e

F Connection to plat manager databaze

Computer data source IHEIiDsEauteil

ILI zer name £ Data view Ihiu:au:l

IF'assw-:uru:I I

Check code page | Check connection | S ave connection |
k. I Cancel | Ay | Help |

Image 30: DB Manager

Important notes on the DB Manager:

Please note the setting for Character set of database server: Here, it is important that you select the ANSI option.
Then, activate the Connection to master data database checkbox and enter the previously defined name of the
ODBC data source in the Computer data source field, hicad in the User name field, and your Password in the
same-named field. The setting options for the “Connection to plot manager database” are only there for historical
reasons and are of no relevance.

Click Save connection to save your settings, then close the DB Manager with OK.
All steps required for the installation are now completed. You can now start HELIOS.
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